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Abstract: This research simulates the use of Google Translate and Microsoft 

Translator in translating Indonesian into English abstract and analyzes errors 

of translation results in the aspect of grammar and spelling using Grammarly 

Premium. This research is descriptive qualitative. The result analysis shows 

several writing issues (errors) of translation results using Microsoft Translator 

(MT), Google Translate (GT), and DeepL Translator (DT) in the aspect of 

clarity, correctness (correction), and delivery. First, there are  26 writing issues 

from MT including 1) 4 clarity (4 unclear sentences), 2) 21 correctness (2 

comma misuse within clauses, 4 punctuation in compound/complex sentences, 

5 wrong or missing prepositions, 3 incorrect verb forms, 2 determiner use, 2 

conjunction use, 2 confusing words, 1 improper formatting), 3) 1 delivery (1 

incomplete sentences). Second, there are 25 writing issues from GT including 

1) 6 clarity (4 unclear sentences and 2 wordy sentences), 2) 17 correctness (1 

misplaced word or phrase, 1 text inconsistencies, 1 comma misuse within 

clauses, 4 punctuation in compound/complex sentences, 3 wrong or missing 

prepositions, 3 incorrect verb forms, 2 conjunction use, 1 confusing word, and 

1 determiner use.). 3) 2 delivery (2 incomplete sentences). Third, there are 10 

writing issues from DT including 3 comma misuse within clauses, 1 incorrect 

noun number, 1 faulty subject-verb agreement, 1 wrong or missing preposition, 

1 improper formatting, 1 misuse of modifiers, 1 conjunction use, and 1 

confused word. Online translator including MT, GT, and DT may help in 

translating foreign language texts, but it does not always provide accurate 

translations. Thus, whether consciously or unconsciously, each translation 

machine contains its traits, whether directly or indirectly, human participation 

cannot be separated from machine translation technology. However, no 

computer translator can provide translations with the same precision as 

humans. It means that they are still a machine that is not able to match human 

capabilities equipped with feelings and thinking processes that describe them. 
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A. INTRODUCTION 

Along with the development of technology, information retrieval can occur anytime and 

anywhere. Through the internet, everyone can easily find any information they want from 

various parts of the world without any restrictions. However, with the ease of accessing 

information from other parts of the world, some obstacles may occur related to the language 

barrier such as English. English is an international language that is widely used by people to 

communicate directly or indirectly. Many people may learn English as a second language. Of 

course, many people need a dictionary to translate English to Indonesian and vice versa in the 

learning process. With the rapid development of the times and technology, many English-

Indonesian or Indonesian-English translator sites can be accessed easily via the internet. 

There are currently many machine translations (online translation) that offer online 

translation services (Chan, 2014). This feature involves translating sentences on a webpage or 

application by simply clicking the mouse (Sin-wai, 2016). Machine translation is the process 

of using artificial intelligence to automatically translate text from one language to another 

(Pudjiati et al., 2022). Online translators use technology to translate large amounts of text to 

and from supported languages. The service translates "source" text from one language to a 

different "target" language. Translation in this way has advantages such as the practicality of 

use, fast results, and low costs. However, translation between distant languages constitutes a 

challenge for machines. The application can easily change and translate the sentences or texts 

that we want into a language that we can understand.  

Google Translate is very easy to use and many different languages can be translated. 

Google Translate generates a translation (Kerr, 2014). Google Translate is Google's free 

service to instantly translate words, phrases, and web pages between English and over 100 

other languages (Brown, 2017). Google Translate, https://translate.google.com/, provides a 

ready-to-use interface for translations (Rothman & Gulli, 2022). Google Translate is one of 

the popular applications for translation. This service is available as a web version and an 

application that can be downloaded on iOS and Android. This application is even able to 

translate, not only in the form of text but also in written photos, handwriting, direct 

conversation sentences, to voice. Besides, Google Translate is not the only translation tool. 

There are other alternative translator applications and sites other that can be an option for us 

(Fitria, 2021c). Like Google Translate, application software from Microsoft can be used. We 

can translate words and phrases as needed. It also can translate text completely from one 

language to another.  
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Maybe many people do not know that the Word application created by Microsoft can 

translate from one language to another quickly. The Microsoft Translator program itself has 

been integrated into various products and services, such as Microsoft Word. Directly, we can 

translate the articles we want into Microsoft Word without the need for additional applications. 

Microsoft Word most popular program in Microsoft (Piko, 2018). Microsoft Word is a word 

processing application developed by Microsoft which was first released on October 25, 1983. 

This application is certainly no stranger to the public because of its advantages in helping to 

complete school assignments, lectures, or other general tasks. Microsoft Word is a word-

processing application program that is often used (Nurhakim, 2015). With its features that help 

work productivity, many people are taking advantage by continuing to use Ms. Words.  

Besides Google Translate and Microsoft Translator, there is another online translator such 

as DeepL Translator. DeepL is a novel machine translation engine introduced in August 2017 

that employs deep learning and NMT to automatically translate between two languages 

(Dressman & Sadler, 2020). It is a Neural Machine Translation Service created by DeepL 

GMBH, a German company specializing in the development of deep learning-based machine 

translation technology (Ganguli & Aggarwal, 2023). Regarding the languages it supports, 

DeepL is regarded as more precise than Google Translate. Compared to Google Translate, 

DeepL translate has a smaller language selection and is more expensive. DeepL Translator has 

managed to differentiate itself by providing more accurate and natural translations compared 

to many other translation tools. DeepL Translator is an online translation application that 

employs Artificial Intelligence (AI) and neural networks to provide more precise and 

trustworthy translations (James, 2023).  

Several previous studies have been conducted related to online translation tools both 

Google Translate and Microsoft Translator. First, Ismail & Hartono (2016) states that there 

are 13 categories of translation errors grammatical errors, terminology errors, omission errors, 

syntax errors, mistranslation errors, literalness/faithfulness errors, usage errors, punctuation 

errors, addition errors, ambiguity errors, word form errors, capitalization errors, and spelling 

errors. It shows the inability of Google Translate to understand the contexts of the texts beyond 

the sentence and errors in the source texts that carried into translation errors in the target texts. 

Second, Tongpoon-Patanasorn & Griffith (2020) state that the quality of the abstracts 

translated by GT may not meet the language requirements needed for academic writing. The 

most frequent errors produced by GT were those of capitalization, punctuation, and 

fragmentation. Third, Napitupulu (2017) states the frequency of errors in the translation of 

abstracts produced by Google Translate The study revealed that 21 frequencies in terms of 
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lexicosemantic errors, 9 frequencies in terms of tense errors, 13 frequencies in terms of 

preposition error, 27 frequencies in terms of a word order error, 15 frequencies in terms of 

distribution and use of verb group errors, 8 frequencies in terms of active and passive voice 

errors. Fourth, Yudiarti (2019) states that the use of Microsoft Translator is still not feasible 

to be used to translate texts without involving translation experts by using suitable 

proofreading and editing. Fifth, Thayyib (2022) states that the incorrect term is the most 

common error identified in translations produced by Google Translate and Bing Translator 

with 152 errors. The majority of the wrong terms came in the translation of adjectives and 

adverbs, which Google Translate and Bing Translator rendered as nouns. Thus, the 

performances of the two machine translators are comparable since each has benefits and 

weaknesses. Sixth, Putri & Nugroho (2022) imply that these two machine translators use 

distinct translation strategies. Because Google Translate translates entire phrases without the 

need for word-by-word translation, the translations produced by Google Translation employ 

more established equivalent translation approaches. As a result, they believe the results are 

less accurate. While Microsoft Translator's translation outputs employ literal translation 

approaches. Microsoft Translator tends to translate word by word, resulting in a less accurate 

n than Google Translate. 

Based on the explanation above the researcher is interested to investigate two machine 

translation tools such as Google Translate, Microsoft Translator, and DeepL Translator, and 

prove their performances in translating Indonesian abstracts into English. Therefore, this 

research simulates the use of Google Translate and Microsoft Translator in translating 

Indonesian into English Abstract and analyzes errors of translation results in the aspect of 

grammar and spelling using Grammarly Premium. 

 

B. RESEARCH METHOD 

This study utilized qualitative research methods. According to Ary et al. (2018), instead 

of numbers and statistics, qualitative research works with data in the form of words, 

photographs, and other visuals and artifacts. In qualitative research, process and meaning 

(subject perspective) are emphasized more. So, the objective of this descriptive study is to 

describe how to utilize the use of Google Translate (GT) and Microsoft Translator (MT). 

Observation is used as the data-collecting technique in this research. Observation is one of the 

strategies available for collecting qualitative data (Phillips & Stawarski, 2016). Observation is 

the act of seeing a thing directly and in-depth to gain accurate information about it. In this 
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study, the researcher observes the simulation of the translation feature of Microsft Translator 

in translating the text Indonesian into English abstract.  

In this study, the data analysis employs three qualitative methods: data reduction, data 

presentation, and data conclusions as stated by Miles & Huberman (1994). During data 

reduction, data collected in the field through observation are summarized, selected, and 

focused on important issues. After the data has been condensed or summarized, it is then 

presented. Observational data were evaluated and thereafter provided in the form of 

pictures/figures. At the stage of data collection, researchers draw conclusions supported by 

substantial evidence. 

 

C. FINDINGS AND DISCUSSION 

Findings 

The findings below simulate the use of Google Translate and Microsoft Translator in 

translating Indonesian into English Abstract. It also analyzes errors of translation results in the 

aspect of grammar, spelling, and punctuation using the app Grammarly in the Premium (paid) 

version. The descriptions can be seen below: 

1. Using Google Translate, Microsoft Translator, and DeepL Translator in Translating 

Indonesian Abstract 

a. Using Google Translate 

In translating using Google Translate, we can go to the Google Translate site. We can 

access it by trying translate.google.com. We copy the text(s) we want to translate. We can 

copy them from a variety of sources, including documents and other websites. We can 

also type our text. The researcher uses one of the examples Indonesian abstract and then 

translates it into Google Translate. The translation result can be seen below: 
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Figure 1. Translation Result by Using Google Translate 

 

We can select the language we want to translate if Google Translate doesn't 

automatically detect the correct language, for example, Indonesian into English. We can 

click the "▼" button to see the available languages. We see the translated text in the right 

column. Automatically, Google will translate into whatever our language is. We can select 

a different language by using the buttons at the top of the column. If no automatic 

translation occurs, we then click the "Translate" button. As a result, Google Translate will 

show the translation in the target language (TL). 

b. Using Microsoft Translator 

In translating using Microsoft Translator, we can open a Word document and select 

the text we want to translate. How to translate in Microsoft Word next, click the 'Review' 

tab then select the 'Translate' button. In the menu, all we have to do is select the 'Translate 

Selection' option. How to translate in Microsoft Word next the 'Translate' menu will appear 

on the right. Then, with the Microsoft Word application automatically, it will automatically 

detect the language of the text. If it does not match, we can select it manually in the 'From' 

menu. The 'To' section will display the translated text in our preferred language. How to 

translate in Microsoft Word will also try to guess the language we want to translate. 

However, we can change it to our preferred language by selecting the desired new 

language.  

In using Microsoft Translator, open a Word document and select the text we want to 

translate. Next, click the 'Review' tab and then select the 'Translate' button. In the menu, 

all we have to do is select the 'Translate Selection' option. Next, the 'Translate' menu will 
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appear on the right. Then, with the Microsoft Word application automatically, it will 

automatically detect the language of the text. If it doesn't match, you can select it manually 

in the 'From' menu. The 'To' section will display the translated text in our preferred 

language. Word will also try to guess the language it wants to translate. However, we can 

change it to our preferred language by selecting the desired new language. In the Word 

application, we can see a quick preview of the translation after the option is selected. If the 

translation is correct, all we have to do is replace the text with the translation by selecting 

the 'Insert' button. Next, Word replaces the original text with a translation. If we want to 

go back to the original, press Ctrl + Z (or Cmd + Z on a Mac) or the Undo button in the 

top left. Second, we can translate entire documents into Microsoft Word. If all the text in 

our Word document will be translated, please select Review > Translate > Translate 

Document. Then the 'Translate' menu option will appear on the right. Then, Word will 

automatically translate the language used in our document. If we prefer to set it yourself, 

change the 'From' option to 'Auto-Detect' according to our preferred language. Next, go to 

the 'To' menu and select the language to translate our document, and then click 'Translate'. 

After Word finishes translating, a new document opens automatically. Next, we just have 

to save the document by pressing File > Save. 

The researcher uses one of the examples Indonesian abstract and then translates it into 

Google Translate. The translation result can be seen below: 

 

 

Figure 2. Translation Result by Using Microsoft Translator  
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In the Word app, we can see a quick preview of the translation once the option is 

selected. If the translation is correct, all we have to do is replace the text with the translation 

by selecting the 'Insert' button. The next way to translate in Microsoft Word, Word will 

replace the original text with a translation. If we want to go back to the original, press Ctrl 

+ Z (or Cmd + Z on a Mac) or the Undo button in the top left. Besides translating text, 

Microsoft Translator also can translate in Microsoft Word entire documents. If all the text 

in our Word document will be translated, please select Review > Translate > Translate 

Document. Then the 'Translate' menu option will appear on the right. How to Translate in 

Microsoft Word will automatically translate the language used in your document. If we 

prefer to set it yourself, change the 'From' option to 'Auto-Detect' according to our 

preferred language. How to translate in Microsoft Word, then please go to the 'To' menu 

and select the language to translate your document, and then click 'Translate'. After 

completing the translation, a new document is opened automatically.  Next, we just save 

the document by pressing File > Save. 

c. Using DeepL Translator 

Deepl Translator is a free online translation service site with fairly good accuracy. 

This site has provided 28 languages and supports 2 types of options, namely Translate text 

and Translate files. For those users who want to translate the entire contents of an 

international journal, use the Translate files feature to make it easier. There are 3 formats 

supported, namely .pdf, .docx, and .pptx. DeepL is an application that can be used as a 

translation application besides Google Translate. We can install it on Windows, MacOS, 

and iOS. There is a free and a pro version available on the official website. The pro version 

provides more complete features with more language choices but does not yet support 

translations in Indonesian. 
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Figure 3. Translation Result by Using DeepL Translator 

 

In translating text with Deepl Translator, the several steps are: We open the Deepl.com 

site in our browser. 2. If the site is already open, then you will be presented with the start 

page on the Deepl Translator site. 3. Then 'Copy' or Copy the abstract of the source 

language journal you want to translate then 'Paste' or Paste on the left side of the page that 

says Type to translate. 4. When finished, we will see the journal abstract translated 

automatically on the right side of the page. 5. We can change the equivalent of the 

translated word by clicking on the word we want to go to until there is a choice of 

equivalent words. 6. After that, click the word equivalent in the abstract we chose to 

replace the previous word. When we can copy it by clicking 'Copy' at the bottom of the 

translation results. 

2. Errors in Translation Results in Google Translate, Microsoft Translator, and DeepL 

Translator 

To know the errors of translation results in the aspect of grammar, spelling, and 

punctuation using the app Grammarly in Premium. Grammarly is the most popular and 

one of the best English grammar check programs available. Grammarly can detect 

grammatical errors, misspellings, improper sentence construction, and plagiarism. These 

can be useful tools for the rules learning and error correction technique since they allow 
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users to complete a task and then rectify their mistakes/errors (Fitria, 2021e). All of these 

capabilities are available to users for free, and we can also upgrade to the Premium version 

to have access to more sophisticated features.  

The researcher uses Grammarly to analyze the error in translation results from Google 

Translate and Microsoft Translator. As research has been conducted by (Fitria, 2021d). 

Grammarly is a great tool for instructors who need to check and analyze students’ writing. 

Grammarly verifies or detects the work being typed based on a variety of factors. In both 

the quality and clarity of the kids' writing, Grammarly's reports revealed several faults. 

Clarity focuses on succinct and straightforward language use, whereas correctness is 

concerned with the technical requirements of writing. 

In using Grammarly, we can go to the official Grammarly website and click on 'LOG 

IN' at the top right of the front page. If we have a Grammarly account, we can log in by 

entering our email and password on the 'Member Login' page. We click Upload New. Click 

'Upload file' as in the image above. After that please select the file we want to check 

through Grammarly. Select the desired writing settings for our article or paper, starting 

from the reader's audience, and formality, to the purpose of the article being written. If we 

want to fix an error, click the error next to the article as in the image above. The red box 

shows typos and suggestions for improvement. When we have finished correcting errors 

in our texts, click 'Download' in the menu at the top left as shown in the image.  
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Figure 4. Checking Error of Translation Result from Google Translate  

Using Grammarly Premium 

Based on the figure above, shows that The text that was previously copied and pasted 

in the Grammarly column will appear on the Grammarly page. Red marks (underlines) are 

writings that need to be corrected) due to errors in writing. Writing errors of words or 

phrases will be seen along with their replacement words, we can correct grammar very 

easily and quickly. Grammarly highlights serious errors in red (grammar, punctuation, and 

proper spelling) as well as technical errors in other colors (style and best practices) when 

used, although it is only available to premium subscribers. When we hover our mouse over 

one of the highlighted words or phrases, we will be allowed to quickly fix the problem or 

read a more extensive description of the error. 
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Figure 5. Writing Issue of Translation Result by Using Microsoft Translator                                             

(MT) and Google Translate (GT) 

Based on the figure above shows the writing issue (errors) of translation results using 

Microsoft Translator (MT) and Google Translate (GT) in the aspect of clarity, correctness 

(correction), and delivery. Clarity is a suggestion for improvement if the text is considered 

unclear or difficult to understand by the target audience. Corrections are suggestions for 

improvement if grammatical errors are found. Delivery is how the context of the text in 

the paragraph and how to improve it. 

There are 26 writing issues from Microsoft Translator (MT) including 1) 4 clarity 

which consists of 4 unclear sentences, 2) 21 correctness which consists of 2 comma misuse 

within clauses, 4 punctuation in compound/complex sentences, 5 wrong or missing 

prepositions, 3 incorrect verb forms, 2 determiner use (a/an/the/this, etc.), 2 conjunction 

use, 2 confused words, 1 improper formatting, 3) 1 delivery which consists of 1 incomplete 

sentences. Besides, there are 25 writing issues from Google Translate (GT) including 1) 6 

clarity which consists of 4 unclear sentences and 2 wordy sentences, 2) 17 correctness 

which consists of 1 misplaced word or phrase, 1 text inconsistencies, 1 comma misuse 

within clauses, 4 punctuation in compound/complex sentences, 3 wrong or missing 

prepositions, 3 incorrect verb forms, 2 conjunction use, 1 confused word, and 1 determiner 

use (a/an/the/this, etc.). 3) 2 delivery which consists of 2 incomplete sentences. Any errors 

that Grammarly catches (indicated by numbers in red circles) are underlined in red in our 

document text. With each suggestion we improve, the number of errors in the red circle in 

the lower right corner of the page will decrease. If all errors have been corrected or ignored 
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(or if we load a document that has no errors), the icon will change to a green Grammarly 

icon. 

Any errors that Grammarly catches (indicated by numbers in red circles) are 

underlined in red in our document text. With each suggestion we improve, the number of 

errors in the red circle in the lower right corner of the page will decrease. If all errors have 

been corrected or ignored (or if we load a document that has no errors), the icon will change 

to a green Grammarly icon. For each detailed writing issue (errors) can be seen below: 

 

  

Figure 6. Checking Error of Translation Result from Microsoft Translator 

(MT) Using Grammarly Premium 

Based on the figure above shows that there are 26 writing errors (red underlined) 

and corrected errors (green underlined) in translation results using Microsoft 

Translator, such as: 1) Unclear sentences in “The purpose of this community service 

activity is to provide understanding and training on MicrEnglish Basic Grammar”. It 

should be written “This community service provides…”. 2) comma misuse within 

clauses in the year. 3) punctuation in compound/complex sentences using commas. 4) 

punctuation in compound/complex sentences of commas. 5) wrong or missing 

prepositions using “about”, so it is deleted. 6) wrong or missing prepositions of “of”. 

7) incorrect verb forms from singular to plural, 8) wrong or missing prepositions “in”.  

9) determiner use of the definite article “the”. 10) conjunction use “and”. 11) confused 

words of “delivery” must be in gerund form, 12) wrong or missing prepositions of “of”. 

13) punctuation in compound/complex sentences after “material”. 14) comma misuse 
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within clauses ‘and”. 15) wrong or missing prepositions “during”. 16) unclear 

sentences in “they even activate their videos while learning, delivery of material, 

during discussion and question and answer sessions. 17) incorrect verb forms from 

present participle into past participle (“participating” into “participated”), 18) incorrect 

verb forms from plural into singular “were” into “was”. 19) unclear sentences. It should 

be written, “The number of participants participating in this activity around 80 were 

high school students and college students from various schools and colleges in 

Indonesia”. 20) incomplete sentences. It should be written, “The number of 

participants participating in this activity was around 80 were high school students and 

college students from various schools and colleges in Indonesia”. 21) determiner use 

of the definite article “the”. 22) conjunction use “and”. 23) improper formatting from 

“topics/themes” into “topics/themes”. 24) punctuation in compound/complex 

sentences after the word “survey”. 25) confused words from “positive” into 

“positively”. 26) unclear sentences. It should be written, “The survey results show that 

their response was positively related to the implementation of this training activity, 

even though they hope to re-hold advanced Grammar training activities and 

topics/themes other English related”. 

 

  

Figure 7. Checking Error of Translation Result from Google Translate (GT) 

Using Grammarly Premium 

 

https://journal.iaingorontalo.ac.id/index.php/al


© Tira Nur Fitria 
Available Online at https://journal.iaingorontalo.ac.id/index.php/al 

 

Al-Lisan: Jurnal Bahasa (e-Journal), Volume 8, No.2, August 2023 129 
 

Based on the figure above shows that there are 26 writing errors (red underlined) 

and corrected errors (green underlined) in translation results using Google Translate, 

such as: 1) Unclear sentences in “The purpose of this community service activity is to 

provide understanding and training on MicrEnglish Basic Grammar”. It should be 

written “This community service activity aims to provide understanding and training 

on …”. 2) Misplaced words or phrases of “basic English grammar”. 3) Text 

inconsistencies (punctuation). 4) comma misuse within clauses after  

“year”. 5) unclear sentences. it should be written “training of basic english grammar 

for beginner learners” was conducted online on…”. 6) incomplete sentences. 7) 

punctuation in compound/complex sentences of using “as”. 8) punctuation in 

compound/complex sentences (comma). 9) wrong or missing prepositions “about”. 10) 

unclear sentences. it should be written “in addition, the lecturer, as a resource person, 

invites participants to activities to discuss various english basic grammar questions 

with each other”. 11) incorrect verb forms from singular into plural. 12) conjunction 

use “and”. 13) confused words of “delivery” into “delivering”. 14) wrong or missing 

prepositions of “of”. 15) punctuation in compound/complex sentences (comma). 16) 

wrong or missing prepositions of “during”. 17) unclear sentences. it should be written 

“they even activate their videos while learning and delivering material during 

discussion and question and answer sessions”. 18) determiner use of definite and 

indefinite article. 19) wordy sentences by using “who”. 20) incorrect verb forms from 

“participating” into “participated”. 21) incorrect verb forms from plural into singular. 

22) unclear sentences. it should be written “the number of participants in this activity 

was about 80, from high school students and various schools and universities in 

indonesia”. 23) wordy sentences. it shoould be written “the form was distributed”. 24) 

conjunction use “and”. 25) punctuation in compound/complex sentences (comma). 
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Figure 8. Checking Error of Translation Result from DeepL Translator 

Based on the figure above shows that there are 10 writing errors, including 3 

Comma misuse within clauses, 1 Incorrect noun number, 1 Faulty subject-verb 

agreement, 1 Wrong or missing preposition, 1 Improper formatting, 1 Misuse of 

modifiers, 1 Conjunction use, and 1 Confused word. 

 

 

Figure 9. Checking Error of Translation Result from DeepL Translator 

Based on the figure above shows that there are 10 writing errors (red 

underlined) and corrected errors (green underlined) in translation results using Google 

Translate, such as 3 Comma misuse within clauses of the words ‘the year 2021, and, 
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survey’. 1 Incorrect noun number from the word ‘Meetings’ into ‘Meeting’. 1 Faulty 

subject-verb agreement from the verb ‘is’ into ‘are’. 1 Wrong or missing preposition 

from ‘about’ into ‘in’, 1 Improper formatting from ‘topics/themes’ into ‘topics / 

themes’, 1 Misuse of modifiers from ‘positively’ into ‘positive’, 1 Conjunction use of 

the word ‘though they’, also 1 Confused word ‘advance’ into ‘advanced’. 

 

Discussion  

Google Translate translates not only in the form of text but also in written photos, 

handwriting, direct conversation sentences, to voice. First, translate Text Using Google 

Translate can translate text easily and quickly. Go to the Google Translate site, namely 

translate.google.com. Copy the text to be translated. Set the translation language. For example, 

we want to use Google Translate English-Indonesian, then in the left column select English, 

and in the right column Indonesian. Paste or paste the text in the left column. Wait a moment, 

the column on the right will automatically show the translation results. Second, translating 

Text into Files Using Google Translate. Besides being used to translate short text, Google 

Translate can also be used to translate text in Word, pdf, ppt, and other file forms. Go to the 

Google Translate page. Click on the document options located at the top left. Continue by 

clicking “Browse your computer” and selecting the file to be translated. If the file has been 

uploaded, then continue by clicking "Translate" Wait a moment and Google Translate will 

show the results. Third, translate Voice Using Google Translate Google's translation 

application can also be used to translate voice. Go to the Google Translate page. Click the 

voice icon on the page. Click speak and move closer to the source of the sound to be translated. 

Wait a moment and Google translator will automatically convert the result of the translation. 

Fourth, translate Live Conversational Sentences Using Google Translate Other translation 

features in Google can be used to translate live conversational sentences. First, open the 

Google Translator page. Click the conversations button. Select the original language button 

and bring it close to the sound source, and Google Translate will automatically play the 

translation results in voice form. Fifth, translate Photos and Text Using the Google Translate 

Language service. Go to the Google Translate page. Click the camera button on the page. 

Photo of the text you want to translate. Wait a moment and Google Translate will automatically 

convert the text in the photo to the language of your choice. If you want to scan and copy the 

text, you can select the available scan options. Next, click "Select all" at the bottom and tap 

the arrow symbol at the top to copy the text. Then, the text from the photo can be converted to 

text and you can copy it right away. Sixth, translating Handwriting Using Google Translate 

https://journal.iaingorontalo.ac.id/index.php/al


© Tira Nur Fitria 
Available Online at https://journal.iaingorontalo.ac.id/index.php/al 

 

Al-Lisan: Jurnal Bahasa (e-Journal), Volume 8, No.2, August 2023 132 
 

The advanced feature available in this online language translation service is translating 

handwriting. Go to the Google Translate page. Click the handwriting symbol. Continue using 

a language we understand. Then, Google Translate will automatically translate the sentence. 

Wait a moment until the text is finished being translated by this translator application from 

Google. 

Those are some of the features that we can use to translate text, images, and voices into 

several languages easily and quickly. It's just that, although very helpful, the results of Google 

Translate's translation are sometimes not quite right. Therefore, please check the results of the 

translation again. Do not make Google Translate the only way to translate text into another 

language. Fitria (2021a) finds that Google Translate is a machine translator, but that the final 

translation result, such as Indonesian articles into English, will always have less clarity and 

accuracy. Due to the difficulty of learning English grammar, it may not be reasonable to expect 

a machine translator to comprehend every facet of human communication (Fitria, 2021a). 

Therefore, the answer to the question regarding Google Translate's clarity and accuracy is that 

it still has a way to go before it can consistently, clearly, and accurately translate the language 

without making any mistakes. In terms of lucidity, Google Translate's English translation is 

still lacking, even though it translated the language word for word. In terms of accuracy, it 

relates to the grammar, punctuation, and spelling rules that are mechanical. Errors in language 

and punctuation are some examples of incorrectness. In a short period, machine translators 

have made great strides; yet, several qualities, such as grammar and punctuation, still lack 

accurate translations. 

Besides Google Translator from Google, there is another online machine translator (online 

translator) from Microsoft Word. Microsoft Office provides the Translation feature. A new 

feature of Microsoft Office since Office 2003 is the Translate facility. This facility allows you 

to translate words into their equivalents in other languages. The translate feature translates 

words into many different languages and helps in the selection of the proper word to use 

(Vanhuss et al., 2016). Microsoft Word allows one to save a Web document, open it in Word 

and translate the text by replacing the source with the target language (O’Hagan & Ashworth, 

2002). But, not all languages can be translated, only languages that have dictionaries can be 

translated. (Marmel, 2013) states that we can translate a word from one language to another 

language using language dictionaries installed on our computers. If we are connected to the 

internet, the translation features to search the dictionaries on our computer as well as online 

dictionaries. The translation feature searches the dictionaries on our computer as well as 
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online dictionaries (McFedries, 2022). Google Translate also looks at various documentaries 

to find the best translation pattern between human-translated texts (Suryani & Fitria, 2022). 

In using this feature, we need to have a connection to the internet because Ms. Word uses 

its cloud server to do this translation (Lee, 2010). Word Translator is powered by the Microsoft 

Translator service. It lets us translate full-word documents or a selection of words, phrases, 

and sentences from one language to another with a few clicks. A word can translate words 

from any language to which it has access to a bilingual dictionary (Camarda, 2004). (Smith, 

2016) states that we can use Microsoft Word to translate our text/document from English to a 

variety of other common languages such as English or other languages. With this translation 

feature, we can translate documents from one language to another without having to use third-

party services such as installing a translation application or uploading them to the internet to 

ask certain websites to do the translation for us. Microsoft Word offers two translation 

conditions, namely translating certain sentences or paragraphs in our Word document or 

completely translating all the contents of our Word document depending on our choices and 

desires (Cram et al., 2013; Duffy, 2013). We can use the Translate feature on the Review tab 

to translate single words or short passages of text into another language or from another 

language into English.  

In translating texts or documents use Microsoft Translator which is integrated into 

Microsoft Word, not all languages can be translated. Therefore, the original language and the 

language that will be translated into both languages must be supported to get the desired 

results, and are required to use the standard language. To translate text into different languages, 

we can use Word's features. Keep in mind that Word translations aren't always perfect 

(Zimmerman et al., 2013). After we've translated all or part of a document, we'll have a 

language expert examine it and make any required changes (Zimmerman et al., 2015). 

Operating the existing translator program requires a good connection. Next, open the 

Microsoft Word application on our device. (Zervaki, 2019). Select the file in Microsoft Word 

that we want to translate both in the form of articles and stories. After opening the file, click 

the review menu at the top of Microsoft Word. In the review menu, there is a translation button 

that we can choose. In the translated menu there are three options, namely, Translate 

Document which we can use to translate the entire document, Translate Selected Text which 

is useful for translating the word or sentence we want, and finally Mini Translator which we 

can use to translate words quickly. If we choose Translate Selected Text, the step we have to 

do is select the part of the document we want first by blocking words or sentences, then 

selecting Translate Selected Text. Then, on the right side of the screen will appear the results 
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of the translation of the word or sentence that we have chosen, and in it, there are language 

options that we can use. If we want to move the translation results into the document, there is 

an insert button below the translated text and the results will go directly into the document. 

When translating text in Microsoft Word or inserting edits in translated Word files, it is 

important to have the View All Formatting Marks option selected in the Options dialog box, 

to avoid deleting the index or other markers (Esselink, 2000). 

Comparison of DeepL Document Translation and Google Translate, both of them have 

document translation features, although the languages that can be translated are far fewer than 

Google Translate, both have their advantages in assembling the translated words. 1. In terms 

of usage, both are very easy to use, we just need to drag and drop the document we want to 

translate and we can get the results right away. 2. In terms of translation speed, DeepL is 

several seconds longer than Google Translate. 3. In translating documents, Google Translate 

also looks superior with the addition of one format, namely xlsx. 4. Another advantage of 

Google Translate is that the number of languages is far more than DeepL. 

Besides, the comparison of DeepL Translator dan Microsoft Translator is: A feature that 

makes DeepL Translator great is its auto-complete sentence and definition features. There is 

availability to translate our texts into 26 different languages. Once we accept the translation, 

we double-click on any word to get more details. Microsoft Translator is an intelligent 

translation app available for Windows, iOS, and Android. It helps users translate images, 

screenshots, text, and voice translation for more than 60 languages. Microsoft Translator is a 

smart and personal translation application developed by Microsoft for personal and business 

purposes. It helps you translate your photos, screenshots, texts, and voice messages. Microsoft 

Translator is a useful offline translation tool for those traveling around the world. 

After using machine translators both Google Translator, Microsoft Translator, and DeepL 

Translator, there are several errors in translation resulting in the aspect of grammar, spelling, 

and punctuation which have been detected by using an online grammar checker named 

Grammarly, especially the Premium version. This result is in line with Asmari (2018) that 

machine translation is a relatively new term in the field of linguistics and that many 

improvements have been made to machine translation over the years to improve its results. 

Consequently, the findings indicated that human translation is more accurate and that machine 

translation has some weaknesses. 

Both Google Translate, Microsoft Translator, and DeepL Translator still have limitations. 

Although it can help readers to translate foreign language texts, it does not always provide 

accurate translations. After checking the results of the English translation using an online 
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grammar check application called Grammarly Premium, it shows that the performance of the 

translated text is not much different.  Thus, whether consciously or unconsciously, each 

translation machine contains its traits, whether directly or indirectly. Human participation 

cannot be separated from machine translation technology (Fitria, 2021a). In other words, the 

best option for users will always be to rely on human translation rather than machine 

translation. However, no computer translator can provide translations with the same precision 

as humans. It means that they are still a machine that is not able to match human capabilities 

equipped with feelings and thinking processes that describe them (Defina et al., 2019).  

Any kind of translating tool, say Google Translate, Microsoft Translator, and DeepL 

Translator, is a tool made to make the translation process easier. The emergence of machine 

translator tools does not mean that the translator's job will just disappear, instead, translators 

should also use the machine translator. This is because machine translators exist to make the 

job easier, not to get the job done. Tools like Google Translate, Microsoft Translator, and 

DeepL Translator are made to mimic human work in translating. Therefore, it is not surprising 

that simple sentences can be translated with the same results as professional translators do. 

However, machine translation results are not entirely accurate. One of the factors causing this 

is the uneven distribution of available language databases, so not all language pairs can 

produce accurate translations. Meanwhile, what we can believe is that machine translation is 

a tool, not a result. If we can make work easier, then we can use, then fix the shortcomings 

produced by the machine. Because language is an abstract thing, has art, and contains 

meanings that can be interpreted in various ways by various people, do not think of language 

as certain. 

Specifically, the discipline of translation is also concerned with machine translation to 

assist translators in assessing the diction employed as a component of language. In this regard, 

it must be emphasized that machine translation exists as an additional tool in the world of 

translation, not as the primary means of translation because the sophistication of the machine 

cannot match the cognitive abilities of the human brain in adjusting translation results to the 

existing context. Sometimes, translation accuracy is subjective, and frequently, it is temporal. 

Therefore, translation by more than one machine translator is permitted. 

 

D. CONCLUSION 

The result analysis shows several writing issues (errors) of translation results using 

Microsoft Translator (MT), Google Translate (GT), and DeepL Translator (DT) in the aspect 

of clarity, correctness (correction), and delivery. First, there are  26 writing issues from MT 
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including 1) 4 clarity (4 unclear sentences), 2) 21 correctness (2 comma misuse within clauses, 

4 punctuation in compound/complex sentences, 5 wrong or missing prepositions, 3 incorrect 

verb forms, 2 determiner use, 2 conjunction use, 2 confusing words, 1 improper formatting), 

3) 1 delivery (1 incomplete sentences). Second, there are 25 writing issues from GT including 

1) 6 clarity (4 unclear sentences and 2 wordy sentences), 2) 17 correctness (1 misplaced word 

or phrase, 1 text inconsistencies, 1 comma misuse within clauses, 4 punctuation in 

compound/complex sentences, 3 wrong or missing prepositions, 3 incorrect verb forms, 2 

conjunction use, 1 confusing word, and 1 determiner use.). 3) 2 delivery (2 incomplete 

sentences). Third, there are 10 writing issues from DT including 3 comma misuse within 

clauses, 1 incorrect noun number, 1 faulty subject-verb agreement, 1 wrong or missing 

preposition, 1 improper formatting, 1 misuse of modifiers, 1 conjunction use, and 1 confused 

word.  
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